CHAPTER

Monitoring and Troubleshooting
Single Domains

Introduction

The previous chapter described TrafficDirector tools that monitor multiple segments and domains.
In this chapter you'll find tools that focus on a single agent and don@inusé these tools to more
closely examine different aspects of network operation. Typically, you'll first use a multi-segment,
multi-domain tool to get a general idea of the portion of your network you want to mtmouse

the single-agent, single-domain tools to zero in on the portion you want to examine more closely.

The single segment and domain monitoring tools are:
Tool What It Does

Segment Zoom Displays statistical data available from a particular agent and
domain. There are two versions of Segment Zoom, a graphical
presentation and a text presentation.

Host List Displays a host list for the selected agent and domain. From the
Host List, you can view the Host Stats Graph and display
utilization, packets, bytes, destinations, and errors.

Conversation List Displays a list that shows which hosts are exchanging packets on
the segment. From the Conversation List, you can view the
Conversation Stats Graph and display utilization, packets, bytes,
and errors.

Host Zoom Displays more detailed information about traffic to and from a
single host. Both graphical and tabular displays are available.

Watchdog Lets you set a threshold on any event, then sends you a trap
message when the event falls above or below the threshold.

Segment Statistics Graph  Provides four data views for the selected segment:
« Vital Signs. A general indication of the health of the segment.

< Size Distribution. Shows how different packet sizes are
distributed in the segment.

< Destination Breakdown Lists packet destinations.

* Error Breakdown . Lists errors.
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Launching Single Agent/Domain Monitoring Tools

Tool What It Does

Short-Term History Graph  Displays short-term data (residing in the selected afmna
period you select.

Long-Term History Graph  Displays long-term data (residing in the selected adena
period you select.

Launching Single Agent/Domain Monitoring Tools

There are two ways to launch single segment/domain monitoring tools:
® Directly from a Traffic Monitor or Protocol Monitor graph

® From theTools menu of a multi segment/domain monitoring tool

Launching Single Agent/Domain Tools Directly from Traffic Monitor or Protocol Monitor
Graphs

You can launch single agent/domain tools from either Traffic Monitor or Protocol Monitor graphs.
To do so:

Step 1 Click on a bar or pie slice in the appropriate graph to select an agent (Traffic Monitor) or an
agent/domain (Protocol Monitor). The Application Launch window appears.

Step 2 Select the Application you want to use.
Step 3 Select the agent and domain you want to view.

Step 4 Click onLaunch.

Launching Single Agent/Domain Tools from the Tools Menu

In Traffic Monitor, Protocol Monitoror Domain Monitoryou can launch a single agent/domain tool
directly from theTools menu. To do so:

Step 1 Select thelools menu from the network monitoring window.

Step 2 Select the segment or domain tool you want to use. For alléroéptDomain Manager,
the Application Launch window appears. The tool you selected is highlighted.

Step 3 Select the Application you want to launch if it is not already highlighted. Then select the
appropriate Agent and Domain.

Step 4 Click onLaunch. The selected application appears.

Segment Zoom Graphical Display

Segment Zoom displays the fiafinformation available from a particular agent for a single domain.
Most of the displays are refreshed every update period. (The update period is user-defined.) Two
displays, graphical and text, are available. Each display provides different information.

® The graphical view is useful in visualizing relationships and trends.

® The text view shows in tabular form specific values for the variables you select.

8-2 TrafficDirector User Guide



Segment Zoom Graphical Display

You can launch Segment Zoom from:
® Traffic Monitor

® Protocol Monitor

® Domain Manager

The graphical view appears by default when you launch Segment Zoom from Traffic Monitor and
Protocol Monitor The text view appears by default when you launch Segment Zoom from Domain
Manager.

Segment Zoom Data Displays
The Segment Zoom Graphical window provides the following data displays.

Note Segment Zoom displays different variables for each of the different types of agent. The
displays reflect whether the network is Ethernet, WAN, FDDI, or Token Ring. The differences are
noted in the descriptions below.

Data Display What it Tells You

Utilization % Displays both maximum and current segment utilizations as a
percentage of total available bandwidth (10 Mbits/sec).

Collision Rate Ethernet only. Displays both maximum and current segment
collisions as a percentage of packets.

Token Packet Rate FDDI only.Displays both maximum and current token packet rate.
MAC Packet Rate Token Ring only.Displays both maximum and current MAC packet
rate.
Error Packet Rate WAN only. Displays both the maximum and current error packet
rate.
Packet Size Displays percentages of both current and historical packet sizes as pie

charts. Six packet sizes are shown.

Packet Distribution Displays percentages of both current and historical packet sizes as pie
charts. Unicast, Multicast, and Broadcast packets appear.

Segment History Segment history appears as three superimposed graphs: Utilization,
Collisions, and Errors. A menu option lets you switch between
short-term history and long-term history.

Top Ten Hosts The ten most active hosts appear. Percent utilization in and out
appeatrs in bar graph form for each host. The total number of hosts
appeatrs in the graph'’s title.
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Segment Zoom Graphical Display

Using the Segment Zoom Graphical Display

To use Segment Zoom:

Step1 Launch Segment Zoom from eitha&affic Monitor, Protocol Monitoyor Domain Monitar
If you launch it from Domain Monitor, switch from the text view to the graphical view
using theShow Graph button on the text view window.

Step 2 Select eitheBhort-Term History or Long-Term History using theView button. The
default is Short-Term History.

Step 3 Select a data sample rate using$aenplebutton. The range is from 15 seconds to 5
minutes. The default is 15 seconds.

Step 4 You can also use thEols menu to do the following:
® Display information about the agent and its MIBs usingAtent Info selection.
® Switch to the Segment Zoom text view using 8tw Textselection.
® Provide a list of current hosts on this segment usingltis List selection.
® Set alarms on selected data usingwradchdog selection.

® View Segment StatisticProvides immediate segment traffic statistics in graphical
form.

® View Short-term History. Provides a history of segment traffic statistics for a short
period. The default is 30 seconds.

® View Long-term History. Provides a history of segment traffic statistics for a longer
period. The default is 3600 seconds.

Zeroing In on Problems Using Segment Zoom

You can tell a lot about whathappening in a particular domain just by looking at the Segment Zoom
graphical display (Collisions, Utilization %, etc.). You can also use Segment Zoom as a starting
point to zero in on host problems.

First, look at the activity of the Top HostolYcan examine a single host more closely by clicking
directly on the bar of the graph that represents the host you want to examine. This launches Host
Zoom (page 8-16), which shows you the Top N hosts that are communicating with this host.

Printing Segment Zoom Information
To print information from the Segment Zoom window:

Step 1 Select the=ile menu.
Step 2 Select Print.

Exiting the Segment Zoom Graphical Display
To exit the Segment Zoom graphical display:

Step 1 Select theé=ile menu.
Step2 Select Exit.
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Segment Zoom Graphical Display

Using the Segment Zoom Text Display

The ext Display window provides additional segmentficahformation in tabular form. Note that
the selected agent and domain appear at the top of the window. The display information shown in
the figure is for Ethernet. It is different for Token Ring networks.

The text display has three list boxes. The information displayed depends on the menus and selection

buttons you select.

To use the Segment Zoom Text Display:

Step 1

Step 2

Step 3

Step 4

Step 5

SelectShow Textfrom the graphical Segment Zoom window. If you are in Domain
Manager, the text display appears first, however.

SelectPropertiesto determine the interval over which displayed data is taken and the type
of statistics displayed. You can select short-term history or long-term history. For Token
Ring segments, you can select either promiscuous statistics or MAC-level statistics. The
default is Short-Term History for Ethernet, or TR Promiscuous Stats for Token Ring.

SelectSort to determine the sort criterion Segment Zoom uses forah@&THosts display
The sort variables ager interval. They are:

® Packets in The number of packets inbound to the host during the interval.

® Packets out The number of packets outbound from the host during the interval.

® Bytes in The number of bytes into the host during the interval.

® Bytes out The number of bytes outbound from the host during the interval.

® Errors out. The number of errors outbound from the host during the interval.

® Broadcasts out The number of broadcasts outbound from the host during the interval.
® Multicasts out. The number of multicasts outbound from the host during the interval.
The default is Packets Out.

SelectSampleto determine the sample intervatuYcan select an interval from 15 seconds
to 2 minutes. The default is 1 minute.

You can select any of the tools available, either fronTdlods menu or from the selection
buttons. Your choices are:

® Agent Info. Provides information on the selected agent.

® Show Graph. Displays the graphical representation of segment zoom.

® Host List. Displays activity for segment hosts.

® Host Zoom. Displays conversations between the selected Top N host and other hosts.
® Watchdog. Invokes the Watchdog tool.

® Segment Statistics GraphProvides a graphical summary of segmenfit¢rafformation.

® Short-term History Graph. Displays a graph of segment activity for a short period of
time.

® Long-term History Graph . Displays a graph of segment activity for a longer period of
time.
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Host List

Segment Zoom Text Display Information

The first list box displays cumulative traffic statistics for the domain. This information is obtained
from theetherStatsTablefor an Ethernet interface, or from the Promiscuous/MAC-level
tokenRingStatsTablefor a Token Ring interface.

The second list box displays Buckets, Interval, and either Skomt-History or Long-&rm History
for all hosts, depending on which history you selected frortbperties menu. This information
is obtained from the long-term and short-term history tables associated with the domain.

Note For a Token Ring interface, either the Promiscuous or MAC-level history information
appears, depending on the option you select.

The third list box displays traffic information for the top N hosts. Hosts are listed by name and
address. You select the ranking of each host usin§dhtemenu at the top of the window. For IP,
IPX, and DECNET domains installed in NET mode or SUBNET mode, the list box displays the
name and logical address. Any other protocol or domain displays information in MAC mode.

Printing the Segment Zoom Text Display

You may want to print the contents of the Segment Zoom list box for your records. To print the
contents of the Segment Zoom list box:

Step 1 Select theFile menu.
Step 2 Select Print.

Exiting the Segment Zoom Text Display
To exit the Segment Zoom text display:

Step 1 Select the=ile menu.
Step 2 Select Exit.

Host List

Host List provides you with a complete list of the hosts and host activity detected by the selected
agent for the specified domaimowycan specify that the list be sorted according to Discovery Order
or MAC Order or by one of the statistical values available irstive menu. You can use Host List

to verify the number of hosts in the domaiou¥an also use it to determine whether a specific host
is included in that domain.

Both a tabular view and a graphical view are available. The tabular view provides more data, but the
graphical view provides an excellent “at-a-glance” view of host activity. The Host List table can
display a maximum of 4096 hosts.

Also using Host List, you can select a host for the specified domain and view various statistics on
the Host Stats GraphoW can use the Host Stats Graph to establish normfad pafterns and later
monitor to catch any emerging problems on the segment. Statistics you can display using the Host
Stats Graph include utilization, packets, bytes, destinations, and errors.
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Host List

Note If the Host/group option is not enabled for the agent/domain combination you select, you'll
see the error message:

Host/group not enabled for this agent/domain!
If this happens, modify the domain installation to enable the Host/group option as described in
“Installing Domains at Agents”.

Using Host List Tabular View
Use the Host List tabular view to see a complete list of host activity.

Step1 Select Domain Manager, Traffic Monitor, or Protocol Monitor from the TrafficDirector
main window, or launch Segment Zoom from an appropriate tool.

Step 2 The next step depends on which tool you selected:
® |f you selected Domain Manager, first select an agent and domain from the list box.

® |f you selected Traffic Monitor or Protocol Monitor, laurtdbst List from theTools
menu, then select an agent and domain.

® |f you launched Segment Zoom from another tool, simply latdadt List from the
Tools menu.

Note If you launched Host List from either Domain Manager or Segment Zoom, the Host List
tabular view appears initiall{ptherwise, the Host List graphical view appéahe graphical view
appears, select ti®ols menu, then select Show Text to see the tabular view.

Step 3 The Host List window appears. To sort the list of hosts according to different parameters,
select theSort menu. The sort parameters are:

® Address Order. Sorts by the address of each host.

® Packets Out Sorts by cumulative number of packets outbound from the host.

® Broadcasts Out Sorts by cumulative number of broadcasts outbound from the host.
® Multicasts Out. Sorts by cumulative number of multicasts outbound from the host.

® Errors Out. Sorts by cumulative number of errors in outbound transmissions from the
host.

® Bytes Out Sorts by cumulative number of bytes outbound from the host.
® Packets In Sorts by cumulative number of packets inbound to the host.
® Bytes In. Sorts by cumulative number of bytes inbound to the host.
® Time Order. Sorts by the order in which the hosts were discovered.
The default is Time Order.
Step 4 To get information about the agent you selected, click oAgieait Info button.
Step 5 To refresh the display, click on tiefresh button.

Step 6 To launch Host Zoom for a specific host, highlight the host in the list box and then click on
theZoom button. Host Zoom is described in the section “Host Zoom” later in this chapter

Step 7 To display the Host List graphical view, click on tBleow Graph button.
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Host List

Step 8 To print the Host List list box data, select #ike menu, then click on Print.

Step 9 To exit Host List, select thieile menu, then click on Exit.

Using Host List Graphical View

Use the Host List graphical view to obtain an at-a-glance view of host activity for a domain:

Step1 Select Domain Manager, Traffic Monitor, or Protocol Monitor from the TrafficDirector
main window, or launch Segment Zoom from an appropriate tool.

Step 2 The next step depends on the initial tool you selected:
® |f you selected Domain Manager, first select an agent and domain from the list box.

® |f you selected Traffic Monitor or Protocol Monitor, launch Host List fromTihas
menu and then select an agent and domain.

® |f you launched Segment Zoom from another tool, simply launch Host List from the
Tools menu.

Note If you launched Host List from either Domain Manager or Segment Zoom, the Host List
tabular view appears initially. Otherwise, the Host List graphical view appears. If the tabular view
appears, select ti®ols menu, then select Show Graph to see the graphical view.

Step 3 The Host List graphical view appears. To sort the graphical display, sel&tdrtheenu.
The sort criteria in the graphical view ardeiént from those in the tabular vieWhey are:

® Packets Out Sorts by cumulative number of packets outbound from the host.

® Broadcasts Out Sorts by cumulative number of broadcasts outbound from the host.
® Multicasts Out. Sorts by cumulative number of multicasts outbound from the host.
® Errors Out. Sorts by cumulative number of errors outbound from the host.

® Bytes Out Sorts by cumulative number of bytes outbound from the host.

® Packets In Sorts by cumulative number of packets inbound to the host.

® Bytes In. Sorts by cumulative number of bytes inbound to the host.

The default is Bytes Out.

Step 4 To set the interval between samples, click on one of the choices fr@artifde menu.
The range is from 15 seconds to 2 minutes. The default is 1 minute.

Step 5 TheToolsmenu lets you get agent information using Agent Info, switch to the tabular view
using Show Text, or set an alarm using Watchdog.

Step 6 You can print the contents of either Host List window by selectingiteenenu and then
clicking on Print.

Step 7 You can exit either Host List graphical window by selectingRifeemenu and then
clicking on Exit.
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Conversation List

Using Host List to View Host Stats Graph

Use the Host List graphical view to display statistics (utilization, packets, bytes, destinations, and
errors) about a specific host for the selected agent and domain:

Step1 Select Domain Manager, Traffic Monitor, or Protocol Monitor from the TrafficDirector
main window, or launch Segment Zoom from an appropriate tool.

Step 2 The next step depends on the initial tool you selected:

® If you selected Domain Manager, first select an agent and domain from the list box.
Now select Host List from th&ols menu.

® If you selected Traffic Monitor or Protocol Monitor, launch Host List fromTivals
menu and then select an agent and domain. Click the Launch button to display the T
N Hosts graph. Select Show Text from ffomls menu.

® If you launched Segment Zoom from another tool, simply launch Host List from the
Tools menu.

Step 3 When the Host List is displayed, first select the address for the host you want to see
statistics for, then click oHost Graph.

Step 4 The Host Stats Graph appears. You can choose from five data views for the selected host.
To view different statistics, select the View Menu and choose from the following:

® Utilization. Shows all statistics (packets, bytes, destinations, and errors) for the host.
® Packets.Shows the number of packets to and from the host.

® Bytes.Shows the number of bytes to and from the host.

® Destinations.Shows broadcasts and multicasts originating from the host.

® Errors. Shows any errors originating from the host.

The default graph shown is Utilization.

Step 5 To set the interval between samples, click on one of the choices fr@artiig@e menu.
The range is from 15 seconds to 2 minutes. The default is 15 seconds.

Step 6 TheTools menu lets you get agent information using Agent Info or set an alarm using
Watchdog.

Step 7 You can print the contents of the Host Stats Graph window by selectiRietimeenu and
then clicking on Print.

Step 8 You can exit the Host Stats Graph window by selectin§iteenenu and then clicking on
Exit.

Conversation List

Conversation List is the tool you’'d want to use to see more detailed information about conversations
between hosts on a segment. Conversation List shows you a listing of all the hosts on a segment that
are exchanging packets. For example, if host A is exchanging packets with hosts D and G, the list
shows a separate line for the conversation between host A and host D as well as a separate line for
the conversation between host A and host G.

You can also use Conversation List to display the Conversation Stats Graph. The Conversation Stats
Graph shows you the utilization, packets, bytes, and error statistics related to a specific
conversational path between two selected hosts on a segment.
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Host Zoom

Using Conversation List to View Conversation Stats Graph

Use the Conversation List graphic view to display statistics (utilization, packets, bytes, and errors)
for conversations between selected hosts:

Step 1
Step 2

Step 3
Step 4

Step 5

Step 6
Step 7
Step 8

Step 9

Host Zoom

SelectDomain Manager from the TrafficDirector main window.

From the agents and domains listed, select the one you want. Make sure that the agent and
domain selection you chose shows a number undé€dhesheading. A number under

this heading indicates that conversations are enabled; if there is no number shown, you
must click oninstall, then selecConversationsto enable them. See the instructions
described in “Installing Domains at Agents”.

SelectConversation List from theTools menu.

From the list displayed, select the source and destination hosts you want to display statistics
for, and click orShow Graph.

The Conversation Stats Graph appears. You can choose from four data views for the
selected host. To view different statistics, selecMiber menu and choose from the
following:

® Utilization. Shows all statistics (packets, bytes, and errors) for the hosts.
® Packets.Shows the number of packets the hosts are exchanging.

® Bytes.Shows the number of bytes the hosts are exchanging.

® Errors. Shows any errors that occur as the hosts exchange packets.
The default graph shown is Utilization.

To set the interval between samples, click on one of the choices fr@arime menu.
The range is from 15 seconds to 2 minutes. The default is 15 seconds.

The Tools menu lets you get agent information using Agent Info or set an alarm using
Watchdog.

You can print the contents of the Conversation Stats Graph window by selectitiig the
menu and then clicking derint .

You can exit the Conversation Stats Graph window by selectirfgjlthenenu and then
clicking onExit.

You can see more detailed information about a host or group of hosts for a given agent/domain by
usingHost Zoom. Host Zoom lists the Top N hosts with which the selected host is having
conversations.

Like Host List, Host Zoom includes both graphical view and tabular windows. The Host Zoom
Graphical window displays only one of seven host traffic criteria at a time, while the tabular view
displays all seven.
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Host Zoom

Using Host Zoom, the Tabular View
To select Host Zoom:

Step 1

Step 2

Step 3

Step 4
Step 5
Step 6
Step 7

Do one of the following:

® Double click on the desired host in the graphical Host List windowouble click on
a host from the Top N Hosts list in Segment Zoom.

® Click onZoom from theTools menu in the graphical Host List window.
® Select the desired host and then clickZoom on the tabular Host List window.

The Host Zoom tabular view appears. Note that the agent and domain you selected appear
at the top of the window. The window lists the addresses of all the hosts that the selected
host is currently having conversations with, along with a number of variables. The name
and address of the host you selected appears at the top of the window.

To change the sort criterion, select 8@t menu. The selections are:

® Utilization In . Sorts by instantaneous percentage of inbound bandwidth to the host.

® Utilization Out. Sorts by instantaneous percentage of outbound bandwidth from the host.
® Packets In Sorts by cumulative number of packets inbound to the host.

® Packets Out Sorts by cumulative number of packets outbound from the host.

® Bytes In. Sorts by cumulative number of bytes inbound to the host.

® Bytes Out.Sorts by cumulative number of bytes outbound from the host.

® Errors In. Sorts by cumulative number of errors inbound to the host.

® Errors Out. Sorts by cumulative number of errors outbound from the host.

The default is Utilization Out.

To change the interval at which samples are taken, click on one of the choices fBamfiie
menu. You can select a sample from 15 seconds to 2 minutes. The default is 1 minute.

To get information on the agent, select #tgent Info button.
To see the graphical view, select Steow Graph button.
To view a graphical presentation of host activity, selecHibst Graph button.

To view host conversations graphically, selectGoav Graph button.

The bottom of the window displays conversations in/out and the update time.

Using Host Zoom, the Graphical View

The Host Zoom graphical view uses the same sort and sample interval criteria as the tabular view.
In addition, you can switch to the text view or set an alarm using Watchdog framailsenenu.

The Host Zoom graphical view gives you an overview of a figstiversations, but it provides less
detailed host information than the tabular view.
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Getting a Graphical View of Segment Statistics

Getting a Graphical View of Segment Statistics

You can choose to see graphical views of the selected segment statistics. The available graphical
segment statistics views are:

® Vital Signs. A general indication of segment health.

® Size Distribution. A graph by packet size.

® Destination Breakdown A graph by packet destination.
® Error Breakdown . A graph by error occurrence.

The default is Vital Signs.

When you select Segment Statistics from the Application Launch window, the Segment Statistics
graph appears. Note that the selected agent and domain appear at the top of the window. The other
three views are similar.

Selecting a Statistical Variable

You can select the statistical variable you view on the Segment Statistics graph. The default variable
is Vital Signs.

To select a variable:
Step1 Select theview menu. The four variable selections appear:
® \Vital Signs
® Size Distribution
® Destination Breakdown
® Error Breakdown

Step 2 Select one of the variables.

Note The statistics that are graphed for each variable are different for Ethernet, Fast Ethernet,
Token Ring, and FDDI/CDDI segments.

Selecting the Sample Interval

You can select the interval over which TrafficDirector collects the data displayed in the Statistics
graph. The range is from 15 seconds to 2 minutes.The default interval is 1 minute.

To select the sample interval:
Step1 Select the&Samplemenu.

Step 2 Click on the appropriate interval.

Selecting the Type of Statistics Displayed

You can select the type of statistics displayed. The type of statistics that are available depends on
whether you are looking at an Ethernet segment or a Token Ring segment.

The default is Short-Term statistics. In addition, the default for a Token Ring segment is
Promiscuous statistics.
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Getting a Graphical View of Segment Statistics

To select the type of statistics displayed:
Step1 Select thd’roperties menu.
Step 2 Select one of the following:
® Click on either Long- or Short-Term History.

® For a Token Ring segment, click on either Promiscuous or MAC-level statistics.

Selecting the Sample Rate

You can select the statistical sample rate, the interval at which TrafficDirector takes new data and
updates the segment statistics. The sample rate ranges from 15 seconds to 2 minutes. The default is
1 minute.

To select the sample rate:
Step1 Select theSsamplemenu.

Step 2 Click on the desired sample rate.

Launching Watchdog from the Segment Statistics Graph

You can launch Watchdog and set alarm thresholds directly from the Segment Statistics graph.
Watchdog is described in Chapter 12.

To launch Watchdog:
Step 1 Select theTools menu.

Step 2 Click onWatchdog. The Watchdog window appears.

Getting Agent Information

You can view a description of the selected agent’s system information and interface configuration
directly from the Segment Statistics Graph.

To view agent information:
Step 1 Select theTools menu.
Step 2 SelectAgent Info. The Agent Information window appears.

Step 3 Click onOK when you are finished viewing the agent information.

Exiting the Segment Statistics Graph
To exit the Segment Statistics graph:

Step 1 Select theé=ile menu.
Step 2 Click onExit.
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Getting Short- and Long-Term History Graphs

Getting Short- and Long-Term History Graphs

Short and long-term histories reside in the agent and show statistical histories over preset time
periods.

Note History statistics are derived from the segment statistics groups of RMON, so in order to get
history graphs the statistics group must be installed in the agent and must have privileges to view the
group history statistics. To confirm or install the statistics group, see Chapter 6.

The default sample period for a short-term history is 30 seconds. The default is 30 minutes for a
long-term history. The actual sample time appears at the top of the graph. The number of samples,
or buckets, stored in the agent is determined when the domain is installed. See “Installing Domains
at Agents”.

Note that the selected agent and domain appear at the top of the window.

Selecting a Statistical Variable

You can select the statistical variable you view on the Short-Term and Long-Term History graphs.
The default variable is Vital Signs.

To select a variable:

Step1 Select theView menu. The four variable selections appear:
® \Vital Signs
® Destination Breakdown
® Error Breakdown

Step 2 Select one of the variables.

Note The Ethernet history graph is shown in the figure. Tdteet Ring and FDDI graphs are the
same, but there is no collision graph for WAN segments.

Selecting the Graphical Representation

You can select the type of graphical representation used with the History graphs. The default graph
type is Plot.

To select the graph type:
Step1 Select the Properties menu.
Step 2 Select the graph type. Your choices are:
® Plot
¢ Area
® 2-D bar chart
® 3-D bar chart
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Getting Short- and Long-Term History Graphs

Setting Alarms from the History Graphs

You can launch Watchdog and set alarm thresholds directly from the history graphs. Watchdog is
described in Chapter 12.

To launch Watchdog:
Step 1 Select theTools menu.

Step 2 Click on Watchdog. The Watchdog window appears.

Getting Agent Information

You can view a description of the selected agent’s system information and interface configuration
directly from the history graphs.

To view agent information;
Step 1 Select theTools menu.
Step 2 Click on Agent Info. The Agent Information window appears.

Step 3 Click onOK when you are finished viewing the agent information.

Printing the History Graphs

You can print the history graphs at any time. To do so:
Step 1 Select the File menu.

Step 2 Click on Print. TrafficDirector prints the history graph to your default printer.

Exiting the History Graphs
To exit the history graphs:

Step 1 Select theé=ile menu.
Step 2 Click on Exit.
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Getting Short- and Long-Term History Graphs
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